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BioTrakII has built-in security features.   
 

Users must log in to use the software.  
 

 

 
Note:  The initial USER ID and 

PASSWORD are  

User ID: setup 

Password: iq 
 
Note:  The User ID and Password fields are case 
sensitive; “setup” and “iq” must be entered in 
lower case as shown. 
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THE BIOTRAKII PROGRAM IS DESIGNED TO INTERFACE WITH SPERIAN GAS 
DETECTORS.  SPERIAN INSTRUMENTATION IS THE NEW NAME FOR 
BIOSYSTEMS.  BIOTRAKII MAY ALSO BE USED WITH MANY DETECTORS WITH 
BIOSYSTEMS LABELING.   
 
SPERIAN GAS DETECTORS HAVE BEEN DESIGNED FOR THE DETECTION OF 
DEFICIENCIES OF OXYGEN, ACCUMULATIONS OF FLAMMABLE GASES AND 
VAPORS AND ACCUMULATIONS OF TOXIC VAPORS. 
 
IN ORDER TO ENSURE THAT THE USER IS PROPERLY WARNED OF 
POTENTIALLY DANGEROUS ATMOSPHERIC CONDITIONS, IT IS ESSENTIAL 
THAT THE INSTRUCTIONS IN THIS MANUAL AND THE OPERATIONS AND/OR 
REFERENCE MANUAL(S) FOR THE GAS DETECTOR(S) BE READ, FULLY 
UNDERSTOOD, AND FOLLOWED. 
 
THIS MANUAL IS NOT INTENDED TO REPLACE THE OPERATIONS AND/OR 
REFERENCE MANUALS FOR THE GAS DETECTOR.  THIS MANUAL IS ONLY 
DESIGNED TO AID IN THE INSTALLATION AND OPERATION OF THE IQ 
EXPRESS SYSTEM AND SHOULD BE USED IN CONJUNCTION WITH THE 
INSTRUMENT REFERENCE OR OPERATIONS MANUAL AT ALL TIMES. 

 
 
 
 
 
 
 

BioTrakII 
Reference Manual 

Part Number 13-325 
Version 1.01 

Copyright 2008 
by 

Sperian Protection Instrumentation, LLC 
Middletown, Connecticut 06457 

 
All rights reserved. 

 
No page or part of this operation manual may be reproduced in 

any form without written permission of the copyright owner 
shown above. 

 
Sperian Instrumentation reserves the right to correct 

typographical errors. 
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Warnings and Cautions 
A. Signal Words 
The following signal words, as defined by ANSI Z535.4-1998, are used in the IQ Express 
Reference Manual. 

 indicates an imminently hazardous situation which, if not 
avoided, will result in death or serious injury. 

 indicates a potentially hazardous situation which, if not avoided, 
could result in death or serious injury. 

 indicates a potentially hazardous situation, which if not avoided, 
may result in moderate or minor injury. 

CAUTION used without the safety alert symbol indicates a potentially hazardous 
situation which, if not avoided, may result in property damage. 
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1. Overview 
BioTrakII is a data management program 
designed for use with Sperian 
Instrumentation and Biosystems gas 
detectors and docking stations.   
BioTrakII can be used to store and view 
data from session downloads, and can also 
be used to program specific user 
requirements into Sperian gas detectors and 
docking stations. 
BioTrakII must be installed on a PC meeting 
the following minimal requirements: 
• Pentium II Processor 400MHz or better 

or equivalent. 
• 512MB RAM. 
• Windows 2000**/XP 
• 30MB hard drive disk space. 
• Serial Port, USB Port and/or IrDA port 

depending on how the instruments will 
connect to the PC 

**Service Pack 3 for Windows 2000 is 
highly recommended.  
The BioTrakII PC Software must be installed 
prior to attempting to connect to an 
instrument or docking station.  The software 
installation procedure is given below in 
section 2.1. 
Note:  The initial release of BioTrakII is 
only useable with the PHD6. 
1.1 PC – Instrument Connection 
The connection between the PC and the 
detector or dock varies by instrument.  Most 
newer Sperian gas detectors (PHD6, 
ToxiPro, MultiPro) connect to the PC via a 
built-in IrDA port on the detector.  Most older 
instruments (PhD Ultra, PhD5, Toxi Ultra) 
connect via serial or USB port through a 
datadock that may also serve as the 
charging station. 
IQ Docking stations can also be used to 
connect the PC to the detector.  The IQ 
Dock can be connected to the PC via USB 
port or via Ethernet.  See the IQ Dock’s 
reference manual for further details. 
1.2 Saving Data 
Downloading data from the detector does 
not ensure that it is saved in a file on your 
PC.   
See section 3.2 for instructions of 
retrieving, storing and clearing data.   

2. Software Installation 
1. Place the installation CD into the PC’s 

CD tray.  The installation screen should 
come up automatically.  If downloading 

the software from the web or a network, 
select run. 

 A series of screens will be shown as the 
software prepares itself for installation. 

 
↓ 

 
2. Click “Next” to continue with the 

installation.  The Licensing Agreement 
screen will be shown.   

 
3. If you accept the terms of the License 

Agreement, click “I accept.....”.  Then 
click “Next” to continue.  The PC 
requirements will be shown. 
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4. Click “Next” to continue.  The Customer 
Information screen will be shown. 

 
5. Enter the name of the user and the 

name of the organization.  Then select 
whether this application may be used by 
“Anyone who uses this computer” or 
“Only for me”.  Then click “Next.  The 
destination folder screen will be shown. 

 
6. To install BioTrakII in the default 

directory at “C:\ Program Files \ 
Biosystems \ IQ Pro \ BioTrakII” click 
“Next”.  To install the files to another 
directory, click “Browse” and use 
Windows Explorer to specify the new 
location.  Click “Next” once this is 
accomplished.  The following screen will 
then be shown. 

 
7. Click “Install” to proceed with the 

installation.  The status of the 
installation will be shown. 

 
8. Once the installation is complete, the 

following screen will be shown: 

 
9. Click Finish to conclude the installation.  

The IQ Express logo will appear on your 
desktop. 

 

3. Software 
To launch BioTrakII , click on the icon on 
your PC’s desktop or access the program 
manually by selecting Program Files / 
Biosystems / IQ Pro / BioTrakII / BiotrakII 
(unless another location was specified 
during the installation). 

 
The log in screen will be shown once the 
software is launched. 

 
If this is the first launch, enter Setup as the 
User ID and IQ as the password.  
Otherwise, enter your user ID and 
password.   
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Once the software is successfully launched, 
the following screen will be shown. 

 
3.1 Connect to PHD6 
To connect to a PHD6, click on the 
Instruments Menu / PHD6.  The connection 
window will be shown. 

 
Click “Connect”.  An information window will 
be shown with instructions on how to 
prepare the PHD6 for the connection. 
To connect to the PHD6 via an IQ6 Docking 
Station, select “Use Biosytems IQ6” prior to 
clicking “Connect”.   

 
Follow the instructions and press “OK”.   
Connection Options will be shown. 

 
Select the appropriate option.  The PHD 6 
control window will be shown with the 
appropriate tab shown for the selection 
made during connection.   

 
Sections 3.2 – 3.4 cover the three 
remaining menu items “Datalogger / 
Eventlogger, Instrument Configuration 
and Communications.   
3.2 Data Control 
The section provides a basic overview of 
data control in BioTrakII.   
3.2.1 Retrieving Data 
To retrieve session data, complete the 
connection from the PHD6 to the PC.  When 
the Connection Options screen is shown 
select Download Datalogger and 
Eventlogger and press OK. 

 
Data may also be obtained from the 
instrument by pressing the “Get Sessions / 
Event Data” from the Datalogger / 
Eventlogger tab after the connection is 
established.   

 
3.2.2 Saving Data 
The best way to ensure that the data in your 
PHD6 is stored on your PC is to enter the 
Setup Menu followed by Options.  Under the 
General Tab, select “Save Downloads to 
Database Automatically if it is not selected.   

 
See section 4.6.2 for further details. 
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Data may also be saved manually by 
pressing the “Save to Database: button, 
which appears on the upper right side of the 
Datalogger / Eventlogger Tab following an 
instrument download.  

 
3.2.3 Clearing data from the PHD6 
To clear the automatically clear the data in 
your PHD6 following download, enter the 
Setup Menu followed by Options.  Under the 
General Tab and select “Clear Datalogger 
After Download” and/or “Clear Eventlogger 
After Download”. 

 
See section 4.6.2 for further details. 
Note:  Enabling either of the “Clear” 
functions without the enabling the “Save 
Download” function may result in lost 
data.   
Data may also be cleared manually by 
pressing the “Clear Datalogger” or “Clear 
Events” buttons, which appear on the upper 
right side of the Datalogger / Eventlogger 
Tab following an instrument download.  

 
3.3 Datalogger/Eventlogger 
The Datalogger/Eventlogger tab includes 
the control for retrieving session data at the 
top of the screen along with seven tab 
options for viewing the data.   

 
The data on the tabs may be printed or 
exported by right-clicking in the data field 
and then selecting Print or Export as 
needed.   

 
Note:  The datalogger in the PHD6 must 
be enabled to download the datalogger.  
If the PHD6 shows Black Box Datalogger 
on instrument startup it must be returned 
to Sperian Instrumentation to download 
the data in the datalogger.  The 
eventlogger in the PHD6 may be 
downloaded and viewed regardless of 
the status of the datalogger. 
Contact Sperian Instrumentation for 
more details.   
3.3.1 Sessions 

 
Sessions contains a comprehensive listing 
of all operating sessions for the selected 
instrument.  The data shown will be limited 
to the data that is in that instrument’s 
datalogger and eventlogger. 
The Sessions tab displays downloaded data 
in a spreadsheet format.  Rows represent 
individual operating sessions.  Columns 
carry a wide array of specific information 
including the instrument serial numbers, 
session start and stop times and whether 
there was an alarm or not.  Placing the 
mouse over the alarm indication cell causes 
the details of the alarm to be shown. 

 
Select a session to view the sensor ranges, 
session records, graph, events, alarms and 
sensor alarms levels. 
3.3.2 Sensor Ranges 
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Sensor ranges for the selected session are 
grouped by sensor and include the sensor 
serial number, minimum sensor reading, 
maximum sensor readings, average sensor 
reading, STEL, TWA, last fresh air cal, last 
span cal and any alarms that occurred 
during the session.   
3.3.3 Session Records 

 
Session records is a more complete sensor 
history than the one given above in sensor 
ranges.  The session records are broken 
down according to the datalogger interval 
with discrete information for each break in 
the data stream.  With the default 
datalogging interval of one minute, the 
sessions records gives data for each sensor 
for each minute of operation in the session.   
3.3.4 Graph 

 
The graph can be configured to show min, 
max, average, STEL (if 
applicable) and TWA (if 
applicable) and 
temperature readings for 
each sensor that was in 
use during the session.  
To change the sensor 
type, select the sensor 
from the pull down box 
below sessions.  
Once Graph is selected, three option 
buttons will appear above the graph:  
Restore, Edit Graph and Print Preview. 

 
The Restore button is used when the zoom 
feature is used and restores the original 
graph. 
Click on Edit Graph to change graphing 
options. Then click OK. 

 
Print Preview option includes a number of 
controls that allow the user to customize the 
graph for printing. 
3.3.5 Events 

 
The Events Tab contains all information 
downloaded from the eventlogger.  The 
eventlogger stores information about alarm 
events only.   
3.3.6 Session Alarms 

 
Session alarms shows all instrument and 
sensor alarms recorded during the selected 
operating session.   
3.3.7 Sensor Alarm Levels 

 
Sensor alarm levels is a list of sensor 
alarms grouped by sensor.   
3.4 Instrument Configuration 

The Instrument Configuration window is 
divided into an upper and lower section.  

 
The upper section contains the following 
tabs: 
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• General 
• Calibration / Bump Testing 
• Features 
• Service / Security 
• Users / Locations 
• Customer Service Screens 

The lower sections contains a tab for each 
sensor that is installed in the instrument. 
3.4.1 General  
The General Tab contains information about 
the instrument including: 

• Serial number 
• Operating language (can be 

modified and uploaded) 
• Battery Type 
• Date (today’s date in the datalogger) 

(can be modified and uploaded) 
• Firmware version 
• Turn on time (for current operating 

session 
• Battery voltage 
• Time (can be modified and 

uploaded) 
• Use PC time option (automatically 

configures the instrument’s clock to 
match the PC’s clock.  This feature 
is enabled at time of shipment). 

• Sampling Interval (can be modified 
and uploaded) 

• Total runtime (for the instrument) 
3.4.2 Calibration / Bump Testing 

 
The Calibration / Bump testing tab contains 
the date of the last full instrument calibration 
and the date of the last bump test (only 
used with the IQ6 Docking Station).  It also 
contains the following options that can be 
set to meet the needs of the user: 

• Cal Due Reminder (can be set to 
disabled or to any number of days 
between every day and every 180 
days). 

• Bump Reminder (only used with the 
IQ6 Docking Station) (can be set to 
disabled or to any number of days 
between every day and every 180 
days). 

• Cal Due Lockout (causes instrument 
to shut down if instrument is not 
calibrated when it is due for 

calibration as defined by the Cal 
Due Reminder. 

• Fresh Air Cal on Startup 
(automatically initiates a fresh air 
calibration procedure as soon as the 
instrument is turned on). 

• Instrument 
calibration / bump 
status (shown as 
three lights at the 
lower middle of the 
upper tab.  Green means that the 
instrument is not due for that type of 
calibration.  Red means that it is due 
for that type of calibration.) 

3.4.3 Features 

 
The features tab contains the adjustments 
for STEL and TWA periods.  
STEL (Short Term Exposure Limit) 
represents the average reading for the past 
5 to 60 minutes of instrument operation.  In 
the past STEL values have been based on a 
15-minute average. 
TWA (Time Weighted Average) represents 
the maximum average concentration to 
which an unprotected worker may be 
exposed over certain period – typically over 
an eight hour working day.  TWA values are 
calculated by taking the sum of exposure to 
a particular toxic gas in the current 
operating session in terms of parts-per-
million-hours and dividing by the specified 
period.  The TWA period setting can be 
adjusted to any whole number between 1 
hour and 24 hours. 

Note:  Lengthening the STEL and TWA 
values tends to diminish the chance for 
STEL and TWA alarms to be activated.  
The PHD6 automatically records the 
STEL and TWA period settings. 
3.4.4 Service / Security 

 
The Service / Security Tab contains the 
Service Reminder setting, Last Service Date 
and the Security Beep setting. 
By enabling the service reminder, the 
instrument can let you know when the 
instrument requires service.  The reminder 
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can be set to any interval in days between 1 
day and 730 days (2 years), or set to Off. 
The Security Beep is designed to notify the 
user that the instrument is powered up and 
running.  Once enabled the PHD6 will emit a 
short audible beep and give a short flash on 
the LED at a user-defined interval.  The 
interval can be set to any intercal between 
one second and one hour.   
3.4.5 Users / Locations 

 
The PHD6 has memory allocated to storing 
user and location information for the current 
operating session.  The user and location 
names must be entered in BioTrak and 
uploaded to the instrument prior to use.  
Once the names are in the instrument, they 
may be selected at startup and will be 
stored with the current operating session 
whenever the instrument is turned on.   
3.4.6 Custom / Service Screens 

 
Enter custom information that will be 
displayed during instrument startup here.  
Text entered under Custom Screens will 
show up during instrument startup.  Service 
screens show up in the PHD6’s Information 
Menu under Service Info. 
3.4.7 Sensor Tabs 

 
The lower half of the Instrument Data 
window contains Sensor Data.  This tab is 
shown regardless of which tab is selected in 
the upper half of the window.   
Each sensor has its own configurable alarm 
settings, the option to return to the default 
settings, all recent calibration data for that 
particular sensor, and the sensor’s serial 
number, expiration date and manufacturing 
date. 
Note:  If a VOC sensor is installed in the 
instrument, the sensor tab for the VOC 
sensor will include the VOC calibration 
gas type and the VOC target gas.   

3.5 Communications 
The communications tab contains a full 
listing of all communications between the 
PC and the instrument.  This is used 
primarily for troubleshooting the PC-
Instrument interface. 

 

4. Menu Options 
BioTrakII’s menu options allow the user to 
control all aspects of the program, from 
generating reports to user access.   
4.1 File Menu 

 
The file menu has three options: a link to IQ 
Database Administrator, the print setup 
control and Exit.   
The IQ Database Administrator program is 
used to create and manage the database 
that is used with BioTrakII.   
See the IQ Database Administrator manual 
for further details.   
4.2 Instruments Menu 
The Instruments Menu allows the user to 
specify the type of instrument that will be 
connected to the PC and to initiate 
communication.   
This option is currently limited to the PHD6, 
but as BioTrakII is expanded, other Sperian 
Instrumentation gas detectors will be added. 
4.3 Lookup Menu 
The Lookup menu is designed to create and 
implement a search query to locate specific 
instruments.   
This option is currently limited to the PHD6, 
but as BioTrakII is expanded, other Sperian 
Instrumentation gas detectors will be added. 
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4.4 Reports Menu 

 
The reports menu allows the user to view 
and print reports created using the data 
stored during instrument download.  Since 
the reports available are identical to those 
available at datalogger downloads, see 
section 3.3 for a more detailed description of 
the available reports.   
Reports can be printed or exported through 
the Tools Menu (see section 4.5 below) or 
by right-clicking in the data fields and 
selecting Print or Export as needed.   
4.5 Tools Menu 

 
The Tools Menu contains the Data Export 
command.  Data from events or sessions 
may be exported as a .csv file.  The .csv file 
can be opened with Microsoft Excel.  
4.6 Setup Menu 

 
The Setup Menu allows access to the User 
List and also has logon and logoff controls.   
4.6.1 Users 

 
The Users option under setup allows users 
to logon or log out of BioTrakII and also 
contains the control for the User List. 
Click on User List to access user settings.  
The Users window will then be shown. 

 

The information from one user will be 
shown.  Programmed user information 
appears at the top of the screen and 
includes the user’s first name, last name, ID, 
password and access level.   
Access level is a three-tiered system.   

 
“Administrative” grants the individual 
access to the entire system.  Both user and 
template information can be modified. 
“Technician” grants access to template 
information, but denies access to user 
information. 
“General Use” allows the individual to use 
the IQ system, but denies access to both 
user and template information. 
The four buttons in the middle of the screen 
are used to scroll through the user list.   
4.6.2 Options 

 
Setup / Options is linked to a form with two 
tabs. 

 
The General Tab contains the following 
options: 

1. Clearing or not clearing the 
Datalogger or Eventlogger following a 
download.   

2. The option to automatically save 
downloads to the IQ database. 

3. The temperature display option (in 
either Fahrenheit or Celsius).  

Note that is Clear Datalogger or Clear 
Eventlogger are selected, the 
corresponding part of the PHD6’s 
memory will be deleted after download 
and may not be retrieved from the 
instrument again.   
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The PHD6 tab is divided into two sections. 
The IQ6 Dock section contains the timeout 
session for the PHD6 when used with the 
IQ6 Dock, as well as the IQ6 Dock’s own 
timeout setting.  The timeout setting is the 
amount of time that the instrument can 
remain out of communication with the dock 
before the dock determines that there is a 
communication problem.  If the 
communication persists the software will 
notify the user.   
The Instrument section includes a control for 
the maximum number of records to 
download during a session, and an option to 
download only alarm information.   
4.7 Help Menu 

 
The Help Menu contains basic information 
about the BioTrakII program.  The first three 
options in the Help Menu allow the user to 
access the built-in Help File and to search 
for specied topics. 
Check for update uses the PC’s internet 
connection to access Sperian’s download 
website to see if a newer version of 
BioTrakII is available. 

The About BioTrakII option contains 
information about the program, such as the 
software version and installation date.   

5. Software Upgrades 
Sperian Instrumentation will release new 
versions of BioTrakII software from time to 
time.  Upgrades may be loaded onto the PC 
from a CD or may be downloaded from the 
Internet. 
To install the new version from CD: 
1. Uninstall the older version of BioTrakII 

by clicking on the Start Button followed 
by Control Panel / Add or Remove 
Programs and select BioTrakII for 
removal.   

2. Place the disk in your PC’s CD-tray.  
The upload will start automatically and 
will immediately prompt you to install the 
software.   

To install from the Internet: 
1. Uninstall the older version of BioTrakII 

by clicking on the Start Button followed 
by Control Panel / Add or Remove 
Programs and select BioTrakII for 
removal.   

2. Upload the new Flash File from the 
Internet.  Go to Sperian 
Instrumentation’s Software Downloads 
website at: 
http://www.biodownloads.com 
Save the new BioTrakII file to the 
following folder:  C:\ Program Files \ 
Biosystems \ IQ Pro \ BioTrakII.  Then 
install the new program by running the 
.exe file from the same directory.  The 
software may also be stored in other 
folders, but the location above is the 
default location that is used during 
software installation for this product.
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Appendix A:  
Calibration Frequency 
One of the most common questions 
that we are asked at Sperian 
Instrumentation is: “How often 
should I calibrate my gas 
detector?” 

Sensor Reliability and Accuracy 

Today’s sensors are designed to 
provide years of reliable service.  In 
fact, many sensors are designed so 
that with normal use they will only 
lose 5% of their sensitivity per year or 
10% over a two-year period.  Given 
this, it should be possible to use a 
sensor for up to two full years without 
significant loss of sensitivity. 

Verification of Accuracy 
With so many reasons why a sensor 
can lose sensitivity and given the fact 
that dependable sensors can be key 
to survival in a hazardous 
environment, frequent verification of 
sensor performance is paramount. 
There is only one sure way to verify 
that a sensor can respond to the gas 
for which it is designed. That is to 
expose it to a known concentration of 
target gas and compare the reading 
with the concentration of the gas.  
This is referred to as a “bump” test. 
This test is very simple and takes only 
a few seconds to accomplish. The 
safest course of action is to do a 
“bump” test prior to each day’s 
use. It is not necessary to make a 
calibration adjustment if the readings 
fall between 90%* and 120% of the 
expected value. As an example, if a 
CO sensor is checked using a gas 
concentration of 50 PPM it is not 
necessary to perform a calibration 
unless the readings are either below 
45 PPM or above 60 PPM. 
*The Canadian Standards 
Association (CSA) requires the 
instrument to undergo calibration 
when the displayed value during a 
bump test fails to fall between 
100% and 120% of the expected 
value for the gas. 
Lengthening the Intervals between 

Verification of Accuracy 
We are often asked whether there are 
any circumstances in which the period 
between accuracy checks may be 
lengthened.  
Sperian Instrumentation is not the 
only manufacturer to be asked this 

question! One of the professional 
organizations to which Sperian 
Instrumentation belongs is the 
Industrial Safety Equipment 
Association (ISEA). The “Instrument 
Products” group of this organization 
has been very active in developing 
a protocol to clarify the minimum 
conditions under which the interval 
between accuracy checks may be 
lengthened. 
A number of leading gas detection 
equipment manufacturers have 
participated in the development of 
the ISEA guidelines concerning 
calibration frequency. Sperian 
Instrumentation’s procedures 
closely follow these guidelines.  
If your operating procedures do not 
permit daily checking of the 
sensors, Sperian Instrumentation 
recommends the following 
procedure to establish a safe and 
prudent accuracy check schedule 
for your Sperian instruments: 
1. During a period of initial use of 

at least 10 days in the intended 
atmosphere, check the sensor 
response daily to be sure there 
is nothing in the atmosphere 
that is poisoning the sensor(s). 
The period of initial use must 
be of sufficient duration to 
ensure that the sensors are 
exposed to all conditions that 
might have an adverse effect 
on the sensors.  

2. If these tests demonstrate that 
it is not necessary to make 
adjustments, the time between 
checks may be lengthened. 
The interval between accuracy 
checking should not exceed 30 
days.  

3. When the interval has been 
extended the toxic and 
combustible gas sensors 
should be replaced 
immediately upon warranty 
expiration. This will minimize 
the risk of failure during the 
interval between sensor 
checks.  

4. The history of the instrument 
response between verifications 
should be kept. Any conditions, 
incidents, experiences, or 
exposure to contaminants that 
might have an adverse effect 
on the calibration state of the 
sensors should trigger 

immediate re-verification of 
accuracy before further use.  

5. Any changes in the 
environment in which the 
instrument is being used, or 
changes in the work that is 
being performed, should 
trigger a resumption of daily 
checking.  

6. If there is any doubt at any 
time as to the accuracy of the 
sensors, verify the accuracy of 
the sensors by exposing them 
to known concentration test 
gas before further use.  

Gas detectors used for the 
detection of oxygen deficiencies, 
flammable gases and vapors, or 
toxic contaminants must be 
maintained and operated properly 
to do the job they were designed to 
do. Always follow the guidelines 
provided by the manufacturer for 
any gas detection equipment you 
use! 
If there is any doubt regarding your 
gas detector's accuracy, do an 
accuracy check! All it takes is a few 
moments to verify whether or not 
your instruments are safe to use.  

One Button Auto Calibration 

While it is only necessary to do a 
“bump” test to ensure that the 
sensors are working properly, all 
current Sperian gas detectors offer 
a one-button auto calibration 
feature. This feature allows you to 
calibrate a Sperian gas detector in 
about the same time as it takes to 
complete a “bump” test. The use of 
automatic bump test and 
calibration stations can further 
simplify the tasks, while 
automatically maintaining records. 

Don't take a chance  
with your life.   

Verify accuracy frequently! 
Please read also Sperian 
Instrumentation’s application note: 
AN20010808 “Use of ‘equivalent’ 
calibration gas mixtures”.  This 
application note provides 
procedures to ensure safe 
calibration of LEL sensors that are 
subject to silicone poisoning. 
 
Biosystems website is located at 
 
http://www.biosystems.com 
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Sperian Instrumentation Warranty Gas Detection Products 
General 
Sperian Protection Instrumentation, LLC (hereafter Sperian) warrants gas detectors, sensors and accessories 
manufactured and sold by Sperian, to be free from defects in materials and workmanship for the periods listed in 
the tables below.  
Damages to any Sperian products that result from abuse, alteration, power fluctuations including surges and 
lightning strikes, incorrect voltage settings, incorrect batteries, or repair procedures not made in accordance with 
the Instrument’s Reference Manual are not covered by the Sperian warranty. 
The obligation of Sperian under this warranty is limited to the repair or replacement of components deemed by 
the Sperian Instrument Service Department to have been defective under the scope of this standard warranty.  
To receive consideration for warranty repair or replacement procedures, products must be returned with 
transportation and shipping charges prepaid to Sperian at its manufacturing location in Middletown, Connecticut, 
or to a Sperian Authorized Warranty Service Center.  It is necessary to obtain a return authorization number from 
Sperian prior to shipment. 
THIS WARRANTY IS EXPRESSLY IN LIEU OF ANY AND ALL OTHER WARRANTIES AND 
REPRESENTATIONS, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, THE WARRANTY OF 
FITNESS FOR A PARTICULAR PURPOSE. SPERIAN WILL NOT BE LIABLE FOR LOSS OR DAMAGE OF 
ANY KIND CONNECTED TO THE USE OF ITS PRODUCTS OR FAILURE OF ITS PRODUCTS TO FUNCTION 
OR OPERATE PROPERLY. 

Instrument & Accessory Warranty Periods 
Product(s) Warranty Period 
Biosystems PHD6, PhD5, PhD Lite, PhD Plus, PhD Ultra, 
Cannonball3, MultiVision, Toxi, Toxi/Oxy Plus, Toxi/Oxy Ultra, 
ToxiVision, Ex Chek 

As long as the instrument is in service 

ToxiPro®, MultiPro 2 years from date of purchase 

ToxiLtd® 
2 years after activation or 2 years 
after the “Must Be Activated By” date, 
whichever comes first 

Toxi3Ltd® 
3 years after activation or 3 years 
after the “Must Be Activated By” date, 
whichever comes first 

Mighty-Tox 2 
Prorated credit is given towards repair or purchase of a new unit 
of the same type.  

 0 – 6 months of use  100% credit 
 6 – 12 months of use  75% credit 
 12 – 18 months of use  50% credit 
 18 – 24 months of use  25% credit 

IQ Systems, Series 3000, Airpanel, Travelpanel, ZoneGuard, 
Gas Chek1 and Gas Chek4 One year from the date of purchase 

Battery packs and chargers, sampling pumps and other 
components, which by their design are consumed or depleted 
during normal operation, or which may require periodic 
replacement 

One year from the date of purchase 

  

Sensor Warranty Periods 
Instrument(s) Sensor Type(s) Warranty Period 

O2, LEL**, CO, CO+, H2S 
& Duo-Tox 2 Years PhD Plus, PhD Ultra, PhD5, PhD Lite, 

Cannonball3, MultiVision, MultiPro, ToxiVision, 
ToxiPro®, Ex Chek All Other Sensors 1 Year 

CO, CO+, H2S 2 Years Toxi, Toxi/Oxy Plus, Toxi/Oxy Ultra All Other Sensors 1 Year 
All Others All Sensors 1 Year 

**  Damage to combustible gas sensors by acute or chronic exposure to known sensor poisons such as 
volatile lead (aviation gasoline additive), hydride gases such as phosphine, and volatile silicone gases emitted 
from silicone caulks/sealants, silicone rubber molded products, laboratory glassware greases, spray 
lubricants, heat transfer fluids, waxes & polishing compounds (neat or spray aerosols), mold release agents for 
plastics injection molding operations, waterproofing formulations, vinyl & leather preservatives, and hand 
lotions which may contain ingredients listed as cyclomethicone, dimethicone and polymethicone (at the 
discretion of Sperian’s Instrument Service department) void Sperian Instrumentation’s Standard Warranty as it 
applies to the replacement of combustible gas sensors. 


